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INTRODUCTION 

PURPOSE AND STRUCTURE 

The exercises presented in this manual are designed to support the implementation of a regionally 

consistent approach to subnational Risk and Vulnerability Assessment (RVA) for ASEAN Member States 

(AMS). Each exercise provides practical, hands-on training with the tools, techniques, and datasets 

required to put the ASEAN RVA Guidelines into practice.  

Exercise 1 provides an overview of secondary data preparation, a process that cleans, combines, and 

standardizes raw datasets for use in indicator development. Exercises 2 and 3 build on these skills, 

taking raw data through the processes of indicator preparation and index construction. Exercises 4 

through 7 provide hands-on tutorials for using GIS in support of Risk and Vulnerability Assessment, 

introducing GIS software and basic methods for spatial analysis and risk mapping. Finally, Exercise 8 

provides a tutorial for map development, a critical step for communicating risk and integrating RVA 

products into decision-making. Objectives, materials and instructions are provided within each exercise.  
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WORKING WITH SECONDARY DATA 

EXERCISE 1: DATA PREPARATION 

OBJECTIVE 

The objective of this exercise is to provide participants with an opportunity to gain practical experience 

in techniques for preparing data for further analysis. Participants will perform a variety of data 

processing steps using sample datasets, including sorting and combining data from multiple 

spreadsheets, performing calculations, dealing with missing values, etc. 

MATERIALS 

This exercise requires the use of Microsoft Excel. To complete the tasks in this exercise you will need 

sample data (to be provided by instructors): 

 Excel worksheets containing data for this exercise can be found in the 

‘ASEAN_RVA_Exercise_1_Data’ folder.  

INSTRUCTIONS 

Sometimes, the indicator that you want to use in analysis must be created using other datasets that are 

available to you. In this exercise, you will combine data from several different Excel worksheets, and 

perform calculations to derive the indicator Percent (%) of Children and Elderly, representing the 

percentage of the population per administrative unit that is under the age of 15 or over the age of 64. 

TASK 1: PREPARING YOUR INPUT DATA 

1. Open the folder entitled ‘ASEAN_RVA_Exercise_1_Data’ and review the contents.  
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2. Recall from the preceding presentation that in order to combine datasets, a common field is 

required. All of the datasets provided include the fields: ‘Level_1_Name’ and ‘Level_1_Code.’ As a 

first step, it will be important to sort data in each worksheet by the same common field. This will 

ensure that when data from multiple spreadsheets are combined, values are associated with the 

correct place name/admin unit. 

a. Begin by sorting each dataset by a common field. In these sample datasets, the common 

field to sort by is, ‘Level_1_Code.’ 

b. How to Sort Using Excel:  

i. Select the ‘Level_1_Code’ column by clicking the column letter ‘B’ directly above the 

field name.  

 

Under the ‘Home’ tab in Excel, click on the small arrow in the lower right-hand 

corner of the ‘Sort & Filter’ option in the ‘Editing’ menu. Choose the ‘Sort Smallest 

to Largest’ option. 

 

ii. Notice that a ‘Sort Warning’ window will appear on your screen asking if you would 

like to ‘Expand the selection,’ or ‘Continue with the current selection.’ It is 

important that you choose the ‘Expand the selection’ option. This will ensure that all 

data in other columns that are associated with the selected data will be sorted along 

with it. 

Choose the ‘Sort Smallest 

to Largest’ option. 

Click the column letter ‘B’ 

to select the entire 

column. 
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iii. Click the ‘Sort’ button in the ‘Sort Warning’ window. The ‘Level_1_Code’ field should 

now appear in numeric order (see snapshot below). Remember to sort all datasets 

that will be used in this exercise. 
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3. It is not uncommon for datasets to be incomplete due to variations in collection methods or 

frequency of collection. It may therefore be necessary to combine data from multiple sources to be 

able to obtain a complete (or nearly complete) dataset. When combining data from different 

sources, it is possible that values will differ from one source to another. A decision regarding which 

will be the primary data source and which will be the supplementary source will be necessary. In this 

step, you will be combining data from two different sources to develop a complete dataset. 

a. Open the dataset entitled, ‘Number of Elderly Supplemental’ and sort by the field, 

‘Level_1_Code.’ Compare the values in this spreadsheet with those in the ‘Number of 

Elderly’ worksheet. 

b. Double-check that both worksheets have been sorted by ‘Level_1_Code,’ then copy the field 

‘Elderly_Persons_2’ from the supplementary dataset into the ‘Number of Elderly’ 

worksheet. You can then copy and paste or drag supplemental values into the 

‘Elderly_Persons’ column. 

c. QAQC: Spot check the values you just copied over with the original supplementary data 

values. When copying over supplemental data, it is good practice to copy both the column 

with the administrative code and the column with data so that you can more easily check for 

errors. Once checked, any duplicate fields can be deleted. 

d. Sort all remaining datasets (following the procedure outlined in Step 2) to create a single 

worksheet that includes data for: 

i. Level 1 Name 
ii. Level 1 Code 

iii. Population 
iv. Children 
v. Elderly Persons 

 

TASK 2: PERFORMING CALCULATIONS TO DERIVE AN INDICATOR 

This task outlines a series of calculations to derive the indicator Percent (%) of Children and Elderly. It is a 

good practice, and recommended, that you copy the contents of this worksheet into a new worksheet 

before performing calculations to ensure that the integrity of the original datasets is preserved 

(especially useful should you need to start over). 
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1. How to Copy Contents into a New Worksheet in Excel:  

a. At the bottom of the worksheet you will see a tab entitled ‘Sheet1.’ Next to it is a “plus” 

symbol.  

 

b. Click the “plus” symbol to add a new worksheet. You have the option to rename the 

worksheet by right-clicking on the tab entitled ‘Sheet2’ and choosing the ‘Rename’ option. 

In the example below, the new sheet has been renamed as ‘Calculations.’ 

 

c. Click on ‘Sheet1’ to make it the active sheet, then click once on the triangle adjacent (in the 

upper left corner) to cell ‘A1’. This will select the entire worksheet. Right click in the same 

location, then click ‘Copy’ from the menu. 

 

d. Click on the ‘Calculations’ worksheet to make it the active sheet, click once on the triangle 

adjacent to cell ‘A1’ just as you did to copy in ‘Sheet1’ (you can alternatively click in cell ‘A1’) 

then right click and choose paste as ‘Values (V).’ 

 

2. Performing Calculations in Excel: To obtain the percentage of the population per administrative unit 

that are children and elderly, you will need to first add the number of elderly persons with the 

number of children per admin unit. You will then multiply the sum by 100, and divide the resulting 

product by the population for each admin unit. If you are confident in using the formula functions in 

Excel, go ahead and perform the calculations described above.  
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For those new to using formulas in Excel, a step-by-step procedure is outline below. These steps 

illustrate two approaches to performing calculations in Excel. 

a. The first calculation will add values in columns D and E for each admin unit. Create a field 

name in cell F1 that is descriptive, brief and clear. In the example below, the new field is 

‘Children_Elderly.’ 

b. Click in cell F2, and then in the ‘Formula Bar’ (denoted by fx). It is here that you will enter 

the calculation to be performed on the data in cells D2 and E2. 

c. Enter the ‘equals’ (=) sign followed by a left parenthesis, click cell D2, insert a ‘plus’ (+) sign 

in the ‘Formula Bar’ window, click on cell E2, add the right parenthesis, and click ‘Enter’ on 

your keyboard. The sum of D2 plus E2 now appears in cell F2. 

 

d. To quickly and easily copy this function to other cells in the same column, click on cell F2. 

Hover your mouse cursor over the lower right-hand corner of cell F2 until a plus ‘+’ sign 

appears. Click the plus sign, and drag down the length of column F. The cells in column F 

should now contain sums of the corresponding values from columns D and E. 

e. The second calculation will multiply the values in column F by 100. Create a descriptive field 

name in cell G1, such as ‘Children_Elderly_by100.’  

f. Click in cell G2, then in the ‘Formula Bar.’ 

g. Enter the ‘equals’ sign (=) and start typing ‘PRO.’ The ‘PRODUCT’ function will appear in a 

list. Double-clicking on the word ‘PRODUCT’ will automatically insert this function and a left 

parenthesis. Click cell F2, insert a comma, and type 100. Add the right parenthesis, and click 

‘Enter.’ The cell G2 now contains the product of cell F2 multiplied by 100. 
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h. Just as you did in step 2d above, copy the function in cell G2 down the length of the column. 

i. The final calculation for this dataset will divide the values in column G by the Population 

values in column C. To begin, create a field name in cell H1 called 

‘Percent_Children_Elderly.’ 

j. Click in cell H2, then in the ‘Formula Bar.’ Enter the ‘equals’ sign (=) and type the letters 

‘QU.’ The ‘QUOTIENT’ function will appear in a list. Double-clicking on the word ‘QUOTIENT’ 

will automatically insert this function and a left parenthesis.  

 

k. Notice that you must enter first the ‘numerator’ followed by the ‘denominator.’ Click cell 

G2, insert a comma, then click cell C2. Add the right parenthesis, and click ‘Enter.’  

l. As before, copy the function in cell H2 down the length of the column. 

 

Congratulations! You have just learned how to combine multiple datasets using Excel and perform 

calculations to derive a new dataset. Two methods for performing calculations were demonstrated here. 

In the first example, you manually spelled out the calculation to be performed. In the second and third, 

you used the ‘PRODUCT’ and ‘QUOTIENT’ functions. As you become more practiced with the functions in 

Excel, you will find ways to refine and/or combine calculations and accomplish the same results in fewer 

steps. 

A Note on Rounding: Based on the number of significant digits, your answers may vary slightly from the 

example provided above. Excel allows you to permanently round any value to a specified number of 

decimal places using the ROUND function. To use the ROUND function, simply type =ROUND([cell to be 

rounded], [desired number of decimal places]). In the example below, we are rounding cell G2 to zero 

decimal places.  
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TASK 3: PREPARING DATA FOR USE IN A GIS 

Three additional steps are required before this dataset is ready for integration into a geographic 

information system (GIS) such as ArcMap. You must convert cell contents from formulas to values, 

address missing values, and perform a quick formatting check to ensure that the data can be easily 

integrated into GIS. 

1. Convert Cell Contents from Formulas to Values: Converting cell contents from formulas to values is 

quick and easy. Two ways of accomplishing this are described here. If you’d like to maintain the 

worksheet with all calculations that have been performed (a good QAQC practice), select the data in 

the ‘Calculations’ worksheet, and click ‘Copy.’ Add a new worksheet to your workbook. Click in cell 

A1 in the new worksheet, then right click and paste the data as ‘Values (V).’ All formulas will be 

removed. 

There are times when it may not be necessary to preserve formulas. In these cases, you can convert 

cells with formulas to cells with values by selecting a column, right-click and choose ‘Copy,’ right-

click again and choose ‘Paste’ as ‘Values.’ The column will now contain values only.  

2. Address Missing Values: You will have noticed that values for the number of children and the 

number of elderly persons are missing for five administrative units. As a result, calculations for these 

admin units were not possible, and cells in column H show a ‘Divide by Zero Error.’  

 

It is helpful to identify missing data by assigning these a value that is unquestionably distinct, 

such as ‘-9999’ or ‘-8888.’ This can be done prior to integrating the data into GIS, or afterwards. 

Important: If further calculations or statistics will be performed using these data, it is best to 

leave cells with missing data blank at this point. 

3. Prepare Data for GIS Integration: Once the initial processing of indicators is complete, a number of 

steps are necessary to ensure that the data that you have been processing are ready for GIS 

integration.  

a. Make sure that when initial processing was completed, data was copied as ‘Values’ into a 

new “GIS ready” worksheet. 

b. Some GIS tools have limits as to the number of characters in field (column) headings, and 

rules regarding syntax. For example, field headings must begin with letters only, and include 

underbars instead of spaces. Shapefiles have a 10-character limit for field headings, so you 

may need to truncate headings while at the same time maintaining as much clarity as 

possible.  

c. Another thing to consider is the order of appearance of fields. How will it display in an 

attribute table? Is the derived dataset (e.g., Percentage of Children and Elderly) prominently 

featured? You will most likely need to remove some of the fields created during data 

processing steps. The image below shows the “GIS ready” form of the data processed for 
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this indicator. Notice that field headings have been abbreviated to 10 or fewer characters, 

several columns have been removed, and the order of field headings has been modified so 

that ‘ChildElder’ (representing the Percentage of Children and Elderly) appears immediately 

following the ‘PlaceCode.’ Data for ‘Population,’ ‘Elderly’ and ‘Children’ have been retained 

for reference purposes. Note also that cells with missing data have been assigned ‘-9999’ 

values. Recall that cells with missing data are best left blank if additional calculations will be 

performed on the dataset so as not to introduce any errors. 

 

d. Take a few minutes to review the data and check for any errors that may have been 

introduced.  

e. Finally, to overcome issues regarding compatibility, convert the Excel (.xlsx) file that you’ve 

been working with into an Excel 97-2003 Workbook (.xls) using the ‘File’ -> ‘Save As’ option 

in Excel. 

It is important that all data processing steps are recorded for the purposes of creating metadata. A good 

practice is to summarize information about the data in a new worksheet so that these notes are readily 

accessible. Useful information to record includes: the data source (including web link or other 

reference), the date the data was downloaded or obtained, format of the data, calculations performed, 

year in which the data was collected, a brief description of each field, etc. 

TASK 4: TEST YOUR KNOWLEDGE 

The following task provides an opportunity for you to test the skills you’ve just learned in working with 

secondary data. Abbreviated instructions (below) will walk you through the steps of processing two 

additional indicators: Physicians per 10,000 Persons and Nurses per 10,000 Persons. If at any point you 

need more detailed instructions, refer back to Exercise 1, Tasks 1 through 3. 
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1. Locate the ‘Exercise 1’  ‘1_TestYourKnowledge’ folder and open the following three datasets: 

Population, Number of Physicians, and Number of Nurses. Sort each dataset by ‘Level_1_Code’ and 

copy data into a new Excel file. Sheet 1 in the new Workbook should contain data for: 

Level_1_Name 

Level_1_Code 

Population 

Physicians 

Nurses 

2. Copy the contents of Sheet 1 into a new worksheet. Recall that you can rename worksheets to more 

easily distinguish between them. In the example below, Sheet 1 has been renamed ‘Data’ and Sheet 

2 has been renamed ‘Calculations.’ 

 

3. Derive the number of Physicians per 10,000 Persons. You will need to perform a few calculations.  

a. First, multiply the number of doctors by 10,000. In cell F2, enter the formula to multiply the 

number of physicians (D2) by 10,000. In this example, a simpler equation was entered into 

the formula window (=D2*10000). Copy the formulas down the length of each column and 

check for errors. 

 

b. Divide the resulting product by the population. In cell G2, divide contents of F2 by the 

Population (C2). In this example, a simpler equation was entered into the formula window 

(=F2/C2). Copy the formulas down the length of each column and check for errors. 
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4. Repeat Step 3 to derive the indicator for Nurses per 10,000 Persons. 

5. When all calculations have been performed, copy the ‘Calculations’ worksheet into a new 

worksheet, remembering to Paste as ‘Values (V).’ Use this worksheet to finalize the data for GIS 

integration. As necessary: 

a. Remove extraneous data fields 

b. Adjust field names 

c. Adjust field order 

d. Check for missing values 

The image below shows a snapshot of a “GIS ready” worksheet. Field names have been truncated, and 

the field order prominently displays the derived indicators. 

 

6. Take a few minutes to summarize the data processing steps just completed in a new ‘Metadata’ 

worksheet.  

7. Finally, convert the Excel (.xlsx) file that you’ve been working with into an Excel 97-2003 Workbook 

(.xls) using the ‘File’ -> ‘Save As’ option in Excel. The data in your ‘GISReady’ worksheet can now be 

easily integrated into GIS. 
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CONSTRUCTING INDICES 

EXERCISE 2: INDICATOR PREPARATION AND SCALING  

OBJECTIVE 

This exercise will demonstrate the steps required to prepare derived indicators for composite index 

construction. Participants will take a collection of derived indicators through the process of 

normalization (or scaling), compression, and ensuring consistent conceptual direction, to create a final 

indicator score. These steps can be applied to create a complete set of indicators that are polished and 

ready to be used to construct the Vulnerability Index, one of the component indices of the Societal Risk 

Index. Similar steps can also be applied to prepare indicators for construction of the Multi-hazard 

Exposure and Disaster Risk Management Capacity Indices. 

MATERIALS 

This exercise requires the use of Microsoft Excel. Instructors will provide two Excel Workbooks: 

 Exercise_2_Sample_Data.xlsx:  This file contains sample data and descriptions for 26 vulnerability 

indicators 

 ASEAN_RVA_Template.xlsx: This Excel Workbook is designed as a guide through the process of 

Index Construction for the ASEAN Risk and Vulnerability Assessment (RVA). It provides field names, 

descriptions, examples, and templates that will be used throughout the training and exercises. 

Please do not hesitate to ask the instructors for help as you navigate this exercise. 

INSTRUCTIONS 

TASK 1: GETTING FAMILIAR WITH THE INDICATORS 

1. Make a copy of the Excel file “Exercise_2_Sample_Data.xlsx” file to work from. This is good practice 

and ensures that you can access the original data should any error occur. 

2. Open your copy of “Exercise_2_Sample_Data.xlsx” – The table contains the sample data that has 

already been derived for you. The file contains two worksheets: 

a. Indicator_Descriptions: Contains field names and descriptions for the 26 indicators 

representing various dimensions of vulnerability 

b. Vulnerability_Indicators: Contains the derived sample indicators which will be used to 

construct the Vulnerability Index. These indicators will be copied and pasted into your 

copy of the ASEAN_RVA_Template.xlsx to be scaled and prepared for index 

construction. 
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TASK 2: GETTING FAMILIAR WITH THE TEMPLATE 

1. Make a copy of the Excel Workbook “ASEAN_RVA_Template.xlsx” to work from. You may want to 

add your initials to the end of the file name to easily distinguish between the two. 

a. Open your copy of “ASEAN_RVA_Template.xlsx” – This Workbook provides 

comprehensive guidance for construction of the ASEAN Risk and Vulnerability 

Assessment (RVA). This file contains 10 worksheets or “tabs”. The first worksheet, 

entitled INTRODUCTION, provides a basic overview of the workbook and a “Table of 

Contents.” Users can navigate between worksheets by using the links in the table of 

contents, or click on the corresponding tab at the bottom of the screen (see image 

below) 

 

2. Briefly explore the worksheets. An annotated example of indicator preparation and scaling for the 

vulnerability indicators is provided in the Vulnerability_Example worksheet. 

3. For this exercise, we will be using the Vulnerability_Template worksheet. Columns are provided for 

you to copy and paste derived indicators. Each indicator will be normalized, checked for 

compression, and reviewed for conceptual direction (processes detailed below). Each step in the 

processing of each indicator will take place in a separate column. Field names and descriptions for 

each column are provided in the Vulnerability_Field_Names worksheet. Columns are also color-

coded for the purposes of organization: 

Indicators 

Scaled and Compressed Indicators 

Indicator Scores and Ranks 

Sub-index Scores and Ranks 

Sub-component Index Scores and Ranks 

Component Index Scores and Ranks 
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a. Note: The template and example worksheets contain active formulas to partially 

automate indicator preparation and index construction, therefore some fields will 

update automatically. These formulas are designed to help you and will be described in 

the following sections. IMPORTANT! Care should be taken not to change or delete 

existing formulas. 

TASK 3: ENTER DERIVED INDICATORS INTO THE TEMPLATE 

1. In the Vulnerability_Template worksheet, the first gold column, “ChildElder” refers to the derived 

indicator representing the % of population that are children or elderly. The derived data that will 

populate this column are provided in the Vulnerability_Indicators worksheet in the 

“Exercise_2_Sample_Data.xlsx” file: 

 

 

2. Inside the Vulnerability_Indicators worksheet, carefully click and drag to 

select all of the data in the “ChildElder” Column. Once selected, right-click and 

select Copy. 

3. Now open the Vulnerability_Template worksheet, right-click the first cell in 

the “ChildElder” Column, and select Paste. 

4. Notice that the values in the adjacent column “ChEldScale” have 

automatically updated. Next, we will explore the calculation that occurs in this 

column.   
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TASK 4: INDICATOR SCALING 

1. Indicators used to construct themes of the Vulnerability Index represent different concepts and 

have inconsistent units, ranges, and scales. In order to make meaningful comparisons between 

datasets, and combine them to create a single composite index score, indicator values must be 

standardized. To do this, we use Min-Max Normalization to re-scale indicator values between 0 and 

1, using the following equation: 

(𝑜𝑏𝑠𝑒𝑟𝑣𝑒𝑑 𝑖𝑛𝑑𝑖𝑐𝑎𝑡𝑜𝑟 𝑣𝑎𝑙𝑢𝑒 − 𝐴𝑀𝑆 𝑖𝑛𝑑𝑖𝑐𝑎𝑡𝑜𝑟 𝑚𝑖𝑛𝑖𝑚𝑢𝑚 𝑣𝑎𝑙𝑢𝑒)

(𝐴𝑀𝑆 𝑖𝑛𝑑𝑖𝑐𝑎𝑡𝑜𝑟 𝑚𝑎𝑥𝑖𝑚𝑢𝑚 𝑣𝑎𝑙𝑢𝑒 − 𝐴𝑀𝑆 𝑖𝑛𝑑𝑖𝑐𝑎𝑡𝑜𝑟 𝑚𝑖𝑛𝑖𝑚𝑢𝑚 𝑣𝑎𝑙𝑢𝑒)
 

a. This equation is being calculated for you in the adjacent column, “ChEldScale”. If you 

click on a cell in this column, you can view the equation used to calculate the scaled 

value in Excel’s “Formula Bar.” 

2. Minimum and maximum values are provided and can be viewed by scrolling to the bottom of the 

worksheet. NOTE: Min and Max values are intended to represent reasonable best case and worst 

case scenarios across the region and were developed based on national level data. They are not 

intended to capture the full range of conditions within the region, nor are they intended to be 

specific to one ASEAN Member State. Therefore, data for some provinces at the very high end or 

very low end will fall outside the given range. 

a. Values that fall outside the given range are highlighted in red in the ChEldScale Column. 

b. For Example, in Row 93, you 

see that the value of 45% 

Children and Elderly falls 

outside the range of 24 to 

40%. Consequently, the 

scaled value is greater than 1. 

c. Since scaled values must fall 

between 0 and 1, any values 

outside this range must be 

compressed. We will explore 

compression in the next task. 

 

 

 

 

 

 

Note: Some Provinces may have missing values. 

These cases are shown in the dataset as “NoData.” 

NoData values cannot be scaled. In the Case of 

NoData, simply type “NoData” in the Scale 

(ChEldScale) column and continue with the exercise. 
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TASK 5: INDICATOR COMPRESSION 

1. Scroll up and down to review all of the normalized values in the ChEldScale column. A total of 12 

provinces have values that fall outside the 0 to 1 range. These cells are highlighted in red. 

2. These values must be manually compressed: 

a. Copy the scaled values from the ChEldScale column to the “ChEldCompr” column.  

b. IMPORTANT: When you paste the data, be sure to select 

the “Paste Values” option (shown in the graphic). If you 

do not select paste values, formulas from the ChEldScale 

column will be pasted – This is not what we want. 

c. Again, values outside the 0 to 1 range will be 

highlighted. 

i. To compress these values: 

1. Assign a value of 1 where the scaled values are greater than 1. 

2. Assign a value of 0 where scaled values are less than 0. 

3. As you replace these values, the cells will no longer be highlighted, as 

shown below: 

 

TASK 6: ENSURE CONSISTENT CONCEPTUAL DIRECTION 

1. In this analysis, the aim is to emphasize areas with high vulnerability. In order to do this, a value of 

“0” needs to consistently represent relatively better conditions (Low vulnerability) and a value of 

“1” needs to consistently represent relatively worse conditions (High Vulnerability).  
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2. However, for some indicators, higher values may represent better conditions and lower 

vulnerability. For example, consider the following indicators where higher values indicate lower 

vulnerability: 

a. % Literacy 

b. Hospital beds per 10,000 persons 

c. Access to improved water source 

3. In these cases, it is necessary to reverse or “reflect” the directionality of the indicator by subtracting 

the normalized (and compressed) value from 1. 

4. NOT all indicators require this reflection. Ask yourself: As the Indicator value increases, does 

vulnerability increase or decrease? 

5. In the case of ChildElder, as the percentage of the population that are children and elderly 

increases, vulnerability also increases. This represents a conceptual match. The indicator does NOT 

need to be reflected. 

6. Since the indicator does not need to be reflected, the compressed value represents the final 

indicator score. Values from the ChEldCompr column can simply be copied and pasted (Paste 

Values) into the “ChEldScore” column. 

 

7. In cases where the final indicator score needs to be reflected, simply calculate the score by 

subtracting the compressed value from 1, as shown below for Access to Improved Water (you will 

process this indicator later). 

 

8. When computing the reflected score, copy and paste the formula into all rows in the Score column 

(this time do not choose Paste Values). Examples of reflected indicator scores for Access to 

Improved Water are provided below: 
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9. A final consideration for the indicator score is dealing with missing values. As noted above, NoData 

values cannot be scaled, and therefore will not be scored or ranked. Simply copy all ‘NoData’ values 

through the Scale, Compression and Score columns. The rank equation will ignore these cells. 

10. After finalizing the indicator scores, rankings will automatically appear in the adjacent column. 

Remember – since we scaled and compressed the indicators using Min and Max values based on 

data for the region, multiple areas may display the same rank at the top and bottom of the 

distribution. This is ok – It is a result of indicator compression. 

 

 

 

TASK 7: PREPARE AND SCALE THE REMAINING INDICATORS 

1. Follow Tasks 3 through 6, entering the remaining derived indicators from 

“Exercise_2_Sample_Data.xlsx” workbook into the template. Remember to carefully consider the 

conceptual match for each indicator. For clarification, refer to the field descriptions, provided in 

both Excel Workbooks. 

  

Where reflection is necessary to ensure conceptual match: 

Reflected Indicator = 

(1 - Compressed Value) 
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EXERCISE 3: INDEX CREATION 

OBJECTIVE 

This exercise builds on Exercise 2: Indicator Preparation and Scaling, using indicator scores to construct 

thematic sub-indices and sub-component indices that comprise the Vulnerability Index. The hierarchical 

approach to RVA allows users to build concepts upwards, developing indices that have distinct 

implications for disaster risk reduction.  

This exercise will result in a better understanding of the composite index aggregation process, which 

combines multiple datasets to represent the larger, multidimensional concept of disaster vulnerability. 

Though much of the aggregation process has been automated, users will review and explore index 

development from normalized indicators through construction of a component index.  

MATERIALS 

This exercise requires the use of Microsoft Excel. Participants will continue using their copy of the 

template provided in the previous exercise: 

 ASEAN_RVA_Template.xlsx: This Excel Workbook is designed as a guide through the process of 

Index Construction for the ASEAN Risk and Vulnerability Assessment (RVA). It provides field names, 

descriptions, examples, and templates that will be used throughout the training and exercises. 

INSTRUCTIONS 

TASK 1: EXPLORING COMPOSITE INDEX AGGREGATION 

1. Index creation includes three levels of indices: component, 

sub-component, and sub-index. Each sub-index and sub-

component index is made up of a varying number of 

indicators. 

2. Indices are computed by calculating the arithmetic mean of 

the scaled scores of the contributing indicators: 

a. Sub-index scores = average of indicator scores 

i. Note: The Vulnerability Index Includes only 2 sub-indices 

b. Sub-component index scores = average of sub-index (or indicator) scores 

c. Component index scores = average of sub-component index scores 

3. Open your copy of Vulnerability_Template Worksheet and scroll right until you reach the first light 

blue column, “PopConcern” 
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4. This column represents the Sub-component Index Score for Populations of Concern 

a. Click on the first cell of data in this column to reveal the calculation: 

 

b. Question: Which Indicator scores are being averaged in this subcomponent? 

5. Scroll Right until you reach the next light blue column. 

a. Question: What is the next subcomponent index? Which Indicators are Included? 

6. The next light blue column, HOutcome is the first of two Sub-Indices of the Health Sub-component 

Index 

a. Question: How is the Health Sub-component Index, “HlthIndex” calculated? 

7. Continue exploring the subcomponents to examine the thematic hierarchy of the Vulnerability 

Index. Finally, scroll all the way to the right of the table and examine the Vulnerability Index, 

“VIndex.” Here, all the thematic sub-component scores are combined to represent the 

characteristics and circumstances of a community, system, or asset that make it susceptible to the 

damaging effects of a hazard. 

TASK 2: DEALING WITH MISSING VALUES IN INDEX CONSTRUCTION 

1. While index construction in mostly automated in the template, users must take care to check for 

missing data values and omit these observations from the index calculations.  

2. For example, the ChildElder Indicator has missing values in five Provinces. Consequently, the 

calculations for the Populations of Concern Subcomponent Index, “PopConcern” should EXCLUDE 

this indicator when taking the arithmetic mean in these Provinces.  

a. To exclude the Indicator, click on the corresponding cell in the “PopConcern” column to 

view the calculation, and Delete the reference cells that contain NoData.  

b. For example, the Indicator Score for ChildElder is in Column F. If Row 15 Contains the 

missing data, cell F15 should be deleted from the PopConcern Subcomponent Index: 
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c. Users must do this manually. Every cell in the index column should be carefully checked 

to ensure that cells containing Missing Data are excluded from the index calculations. 

3. This raises an important question: 

If I’ve removed the indicator, can I still calculate the Sub-index, Sub-component and Component Index 

Scores for those Provinces? 

4. While there are no concrete rules to help answer this question, we offer the following general 

guidance: 

a. If an index calculation is missing data for only one indicator, proceed in calculating the 

index. 

i. In the example above, the Populations of Concern Sub-component Index only had 

missing values for one indicator – Children and Elderly – so we were able to 

calculate the index. 

b. However, it is important to Document all missing data: 

i. Note all provinces with missing data 

ii. Note which indicators are missing 

iii. Note which sub-indices, sub-components, and component indices are affected. 

c. If an index calculation is missing data for more than one indicator, do not calculate the 

index. 

USING THE TEMPLATE TO CALCULATE INDICES FOR YOUR MEMBER STATE 

Aside from these exercises, the provided template can be used to calculate Component Indices (Multi-

Hazard Exposure, Vulnerability, and DRMC), as well as Risk and Lack of Resilience Indices, using real data 

with minimal adjustments. Rows can be removed from the bottom of the worksheets without affecting 

index calculation. These exercises can serve as guidance for processing your Member State’s data during 

implementation of the ASEAN RVA Guidelines. 
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USING GIS IN SUPPORT OF RISK AND VULNERABILITY 

ASSESSMENTS 

EXERCISE 4: GETTING FAMILIAR WITH GIS 

Many of you may be familiar with GIS, or even have used a GIS at some time. Though GIS is often used 

to make maps, it provides a powerful toolset beyond mapmaking. A GIS is a computer based system that 

helps us create, maintain, store, analyze, display, and distribute spatial data. A GIS seamlessly links 

coordinate data that locates an object on a map to attribute information that tells us something about 

it.  

GIS data are generally stored in one of two formats, known as vector and raster. Vector data are 

representations of points, lines, or polygons. Raster maps take a different approach by dividing the map 

area into a grid of rectangular cells (usually square). Each grid cell has a value attached to it, which may 

be a categorical value (e.g. land use code), a continuous numeric value (e.g. elevation), a color value 

(e.g. a single pixel in an aerial photo), or a null value to indicate no data. 

OBJECTIVE 

This exercise will explore basic GIS functionality and tools using ESRI ArcGIS Desktop. The result will be a 

better understanding of GIS functions, the ArcGIS Interface, and basic tools to analyze spatial 

information. ArcGIS Desktop was selected to provide a consistent reference during training. QGIS and 

other open source options have similar capabilities, but somewhat different interfaces. 

MATERIALS 

This exercise requires the use of ESRI ArcGIS Desktop. Bundled in the software are three primary 

applications:  

 ArcMap: ArcMap allows the user to display and query maps, create quality hardcopy maps and 

perform many spatial analysis tasks. ArcMap provides an easy transition from viewing a map to 

editing its spatial features. 

 ArcCatalog: Allows users to easily access and manage geographic data that is stored in folders on 

local disks or relational databases that are available on the user's network.  Data can be copied, 

moved, deleted, renamed and quickly viewed before it is added to a map.  Metadata can also be 

viewed and authored in ArcCatalog. 

 ArcToolbox: Provides a comprehensive collection of tools for performing complex geoprocessing 

operations, including data alteration and information extraction. ArcToolbox can be accessed from 

both ArcMap and ArcCatalog. 

Instructors will provide the following spatial datasets in the Exercise_4_Data Folder: 

 lspop2014_ASEAN.tif: Raster contains 2011 population estimates with a grid cell size of 

approximately 1 km. 
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 Roads.shp: Shapefile contains major roadways in AMS. 

 seaports.shp: Shapefile contains major roadways in AMS. 

 stormzones.shp: Shapefile contains major storm zones across AMS. 

 volcano.shp: Shapefile contains volcanoes in AMS. 

 Admin0_gaul_asean.shp: Shapefile contains level 0 administrative boundaries for AMS. 

 Admin1_gaul_asean.shp: Shapefile contains level 1 administrative boundaries for AMS. 

 Admin2_gaul_asean.shp: Shapefile contains level 2 administrative boundaries for AMS. 

INSTRUCTIONS 

TASK 1: DATA MANAGEMENT IN ARCCATALOG 

1. ArcCatalog is used for managing your spatial data, creating new datasets, database design, and for 

creating and managing your metadata.  This tool can be accessed in multiple ways, including 

through the ArcMap application or the “Start” menu on your Desktop. 

a. Start by Clicking your Start Menu or Desktop Icon > Go to ArcGIS or Search for 

ArcCatalog> Double click ArcCatalog 

 

 

Menu & Toolbars 

1. The menu options and toolbars share a similar look and feel to the ArcMap desktop application.  

From here, users are able to launch tools and applications, connect to workspaces, and customize 

the interface. 

 

2. From the toolbar, click the “Connect to Folder Button” navigate to ASEAN_RVA_Exercise_4_Data 

3. Using the Connect to Folder button allows you to create short-cuts to your workspace. 
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Catalog Tree 

1. The Catalog Tree allows you to organize folders and 

data, and build project databases on your computer.  

You can also create empty shapefiles and 

geodatabases to be edited within ArcMap. 

2. Navigate to ASEAN_RVA_Exercise_4_Data 

3. You will see a list of shapefiles. The .shp extension of 

the file means that these files are in shapefile format 

and thus can be read by ArcGIS. Although this is not 

the only file format ArcGIS can read, it is a popular 

format and the one we will use for training. 

 

 

Preview, and Metadata Description 

Preview 

1. If you select a data source in the catalog tree or 

Contents tab (e.g., Admin0_gaul_asean.shp), you 

can view it in several ways, depending on the tab that 

you choose. Each tab has a toolbar associated with it 

that allows you to modify how you can view your 

data.  You can switch between Geography and Table 

at the bottom of the window. 

 

Common Data Formats 

GEODATABASE   

Geodatabases define, 

manage, process and store all 

the types of data that can be 

used in ArcGIS (i.e., feature, 

rasters, relationships, 

attributes, etc)  

SHAPEFILES  

A shapefile format is a widely 
adopted format and 
comprises three or more 
associated files. Be careful 
copying this data to a disk. It 
is recommended you use 
ArcCatalog or Zip files 
together when moving across 
networks. 

LAYER  

The layer file (.lyr) stores 
symbology, labeling 
properties, scale, and other 
properties that can be moved 
across ArcMap projects.  

RASTER / IMAGE FORMATS  

ArcGIS accepts and uses a 
variety of image and GRID 
formats   

TEXT FILES  

ArcMap can view tables in 
Excel 2007 or earlier, .csv, 
or.txt formats.   
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Metadata 

1. By clicking on the Description tab, you can view Metadata about the dataset if available.  You can 

also easily create, edit and import pre-existing metadata to document information about your 

datasets. 

 

Launching ArcMap 

1. ArcMap is the tool for creating, viewing, querying, editing, composing, and publishing maps. We will 

open ArcMap through ArcCatalog. You can also launch ArcMap through Desktop icons or the Start 

Menu.   

2. From the Toolbar at the top of ArcCatalog, locate and click on the ArcMap button 
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TASK 2: EXPLORING ARCMAP 

1. When ArcMap opens, a dialog box may appear highlighting recent project history, or allowing a user 

to search for a previously saved document.   

2. We will be setting up a new project so click “Cancel“ if prompted with this box. 

 

ArcMap Look and Feel 

1. The toolbars and windows are customizable to your preference.  You can add, remove, and change 

the location of each by clicking and dragging a toolbar to the desired location.  You can add tools by 

clicking on the Customize drop down menu.  We will be using the; Tools, Standard, and Draw 

toolbars 

 

 

Tool Bars 

1. The Standard toolbar is used to save a copy of your map, add data, and access ArcCatalog and 

ArcToolbox functions.  We will start by saving the map to your local Exercise 4 directory. 
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2. Click on the Save button , navigate to your ASEAN_RVA_Exercise_4_Data folder and enter the 

file name “ASEAN_Exercise_4_GIS”. 

 

a. *Tip: ArcMap documents are sometimes not compatible with older versions of the 

software.  You can save your project as an older version by selecting the File menu and 

clicking on Save A Copy 

 

 

3. You will now add the GIS datasets (or layers) to the map.  From the Standard Toolbar, click on the 

Add Data icon and add all the layers located in the ASEAN_RVA_Exercise_4_Data folder. 

(*Tip: Use the Shift / Ctrl key on your keyboard to select multiple layers.) 
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4. Your map should look like the image below.  Each of the newly added layers will be located within 

the Table of Contents window on the left side. The Data Frame on the right side will display the 

geospatial data.  Don’t worry if the colors are different. ArcMap will choose random colors to 

symbolize points, lines, polygons, and raster will always be given a grey scale by default. 
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Navigation 

1. Using the Tools toolbar, you can pan, zoom in, zoom 

out, select, and identify data. NOTE: If you hover your 

cursor over a tool, ArcMap provides a tooltip with 

additional information on how to use the tool.  

 

2. Using the Zoom In tool , click and drag a box 

around the ASEAN Countries to zoom in closer 

  

3. Using the Pan tool, click and drag to pan through 

the map view 

4. Zoom in to an area that interests you. Use the 

Identify tool  by either clicking on a feature, or 

click and dragging a box to select multiple features. 

5. The resulting information shown in the Identify 

window (see example below) represents the selected features’ attributes. This information is stored 

in tabular format and is associated with the geographic feature. The following task will explore 

attributes tables and basic functionality. 

Common Data Types 

POINT  

Represents a discrete 

geographic feature or even.  

For example, a city, hospital, 

or earthquake epicenter. 

LINE  

Represents a linear 

geographic feature such as a 

road, river, or elevation 

contour. 

POLYGON 

Represents an enclosed 

geographic surface or area 

such as an administrative 

boundary, or evacuation 

zone. 

RASTER  

A spatial data model that 

defines space as an array of 

equally sized cells arranged in 

rows and columns such as a 

digital elevation model (DEM). 
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TASK 3: EXPLORING ATTRIBUTE TABLES 

1. The attribute table contains available data for all features and allows a user to manipulate and work 

with it. The information in the attribute table is linked to the spatial information used to display the 

features in the viewing window.  

2. Open the attribute table of the “seaports” layer by right-clicking on the layer name in the Table of 

Contents and clicking on Open Attribute Table. 

3. The “seaports” Attribute Table will open in a new window.  In ArcMap terminology, the column of 

each table is called a Field.  Within the Attribute Table, you can view the attributes associated with 

each seaport, sort fields, add new fields, query attributes, edit attributes, and join tables as well as 

other tasks.    
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4. Most of your available functions are accessible by clicking on the Table Options button  

located on the top left of table toolbar.  You can also right-click on each Field in the attribute table 

to bring up additional menu options. 

Searching Attributes 

1.  You can query data by clicking on the Table 

Options button and selecting Select By 

Attributes… from the dropdown menu.  A new 

window will open where you can select the 

Field on which to query.  For this exercise we 

will select all seaports that are in Indonesia. 

2. Within the Select By Attributes window, 

double click on “Country” and verify the Field 

has been added to the “SELECT * FROM 

seaports WHERE:” window.  

3. Next click on the Equals button.  

4. Ensure the “Country” field is still highlighted in 

the top window and click on Get Unique 

Values to see a full list of the available 

countries. 

5. Your “Select by Attributes” window should look like the image below: 
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a. Click the Apply button to view the results in the table. 

 

6. You can use the additional buttons found within the Select by Attributes window to create 

more complex queries including multiple attributes, or value ranges for numeric fields. 

TASK 4: EXPLORING LAYER PROPERTIES AND SYMBOLOGY 

1. The Layer Properties window is the best method to interact with an individual data layer and allows 

you to effectively manage most aspects of the layer including: applying symbology, adding a 

description, setting data source location, setting a scale range, managing the attribute table and 

field names, labeling features in your map, and joining different tables together using a common 

field.   

2. To access the Layer Properties window, double click on the “Seaports” layer or right-click to activate 

an action tab and select Properties and browse through the tabs. 
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Symbology 

1. Symbology determines how features are represented on a map. Using appropriate symbology can 

help make communication more effective. There are many ways to alter the appearance of features, 

we will look at the more common methods using the Layer Properties window.  

Simple Symbology 

2. Select the Symbology tab under the Layer Properties window for “Seaports”. 
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3. For data layers with a Single Symbol such as seaports, you can change the symbol by clicking on 

 which will activate another Symbol Selector window: 

 

4. From the Symbol Selector window, you can scroll through a list of default ESRI symbols and choose 

one that fits your needs.  You can also search by keyword such as “Seaports” to narrow your search.  

ArcMap also has a number of other Style References that do not display in the Symbol Selector by 

default.  You can see a list by clicking on the Style Reference button in the 

Symbol Selector window. 

5. Find an appropriate symbol for Seaports using one of the functions described.  You can adjust the 

size and color now.  The size depends on various factors such as the size of your map, scale, and the 

density of other symbology that is used.  It will take time to learn the best combination. In this 

exercise we are mainly focusing on how to modify symbology. 

a. When finished click the OK button 

Category Symbology 

1. You can also symbolize data based on Categories found within the Attribute Table for each data 

layer.   

2. Open the Layer Properties window for “volcano” and go to the Symbology tab. 
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3. Under Categories (left side of window) click on 

Unique values.  Select the field you would like to 

symbolize on under Value Field, choose “type”, and 

click the Add All Values button.  A list should appear 

showing all the volcano types listed in the attribute 

table.  You can now select individual symbology for 

each type.   

a. When finished click the OK button 

Quantities Symbology 

1. You can symbolize data layers based on quantities, or 

numeric value ranges where applicable.  Quantitative 

symbologies differ based on the method of 

classification. Classification dictates how data are 

grouped into numeric classes. 

2. For the purposes of this exercise, we have added 

Population data to the Administrative Level 0 

boundary from the 2014 World Bank statistics.   

3. Open the Layer Properties window for 

“Admin0_gaul_asean” and go to the Symbology tab.   

4. Select Quantities, Graduated colors from the left 

side and select Population as the Value Field 

Common Quantitative 
Classification Methods 

EQUAL INTERVAL 

Divides data into classes of 

equal range (e.g. max – min 

for each class is equal). For 

example: Data values range 

from 0-150. Three equal 

interval classes: class1= 0-50; 

class2= 51-100; class3=101-

150. Each interval = 50. 

QUANTILE 

Places an equal number of 

data observations in each 

class (e.g. quartile, or 4 

quantile classes each 

represent 25% of the data). 

NATURAL BREAKS 

Using a clustering approach, 

classes are optimized to 

minimize differences within 

each class of data and 

maximize differences 

between classes. Searches for 

natural separations in data 

values. 

STANDARD DEVIATION 

Places break points above and 

below the mean value at 

intervals of 1, 0.5, or 0.25 

standard deviations until all 

values are included in a class. 
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5. You can adjust the number of Classes or Method of Classification by clicking on the Classify button. 

Briefly explore the different classification methods and press ‘Apply’ to see how they change your 

map.  

a. You can also create your own classification by choosing the Manual methods from the 

dropdown and typing your own Break Values. 

 

6. Adjust the ranges to rounded numbers by typing the break values listed below: 

a. 5,000,000 

b. 15,000,000 

c. 50,000,000 

d. 100,000,000 

e. 300,000,000 
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7. When you have identified your value range and number of classes, you can select a Color Ramp and 

edit the Labels for your map. 

 

a. When finished click the OK button 

8. Finally – SAVE A COPY OF YOUR MAP!  We will use this Map Document (.mxd file) again to create a 

map product in Exercise 8. 

TASK 5: EXPLORE ARCTOOLBOX 

1. ArcToolbox is a central application where you can find, manage and execute geoprocessing tools. 

ArcToolbox can be used within both ArcMap and ArcCatalog. To open ArcToolbox, click the 

ArcToolbox button  from the standard toolbar. 

 

 

2. From the ArcToolbox window, you can 

explore the collection of Geoprocessing 

Tools available. 

a. To open a tool, simply double-

click it. 

b. Explore the Intersect tool, 

found within Analysis Tools > 

Overlay > Intersect. 



 

39 

 

3. From the Intersect window, click Show Help>> for an explanation of the tool’s function.  

a. We will use the intersect tool in a later exercise. 

 

 

4. Choose one other tool from the Extract or Overlay Toolbox. What does it do? Why might you use it? 
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EXERCISE 5: CREATING GEOSPATIAL FILES FROM TABULAR DATA 

OBJECTIVE 

This exercise will demonstrate the creation of geospatial data from tabular files, including the 

conversion of x,y coordinates to spatial points and tabular joins. The result will be a comprehensive 

spatial dataset generated from tabular files. 

MATERIALS 

This exercise requires the use of ESRI ArcMap. Instructors will provide the following datasets in the 

ASEAN_RVA_Exercise_5_Data folder: 

 ASEAN_Seaport_Coordinates.csv: A comma-separated file including latitude and longitude 

coordinates for seaports in AMS. 

 seaport_attributes.xls: An Excel file containing detailed seaport attributes. 

INSTRUCTIONS 

TASK 1: CREATE A POINT LAYER FROM X,Y COORDINATES 

1. Open a new ArcMap document. Click on the Add Data 

icon  and navigate to the 

ASEAN_RVA_Exercise_5_Data folder to add the table 

“ASEAN_Seaport_Coordinates.csv” 

a. Right-click the table and choose Open. 

i. Notice that this is a tabular file – its 

features do not draw in ArcMap. 

However, the table contains coordinates 

(latitude and longitude) that allow us to 

create spatial features from the tabular 

information. 

2. Close the table and right-click the layer again from the 

Table of Contents. This time, choose Display XY Data 

a. For X Field, choose longitude 

b. For Y Field, choose latitude 

c. Click OK 
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Note: A window will pop up telling you that the layer will not have an Object-ID Field. Without this field, 

the layer may have limited functionality in ArcMap. To address this issue, we will export the layer as a 

new shapefile. Click OK. 

3. You should now see a new layer – “ASEAN_Seaport_Coordinates.csv Events” in ArcMap’s Table of 

Contents. Right-click this layer and Choose Data > Export Data. Navigate to your Exercise 5 folder 

and save the layer as “ASEAN_Seaports” 

a. For Save as Type, choose Shapefile. 

b. When asked “Do you want to add the exported Data to the map as a layer?” Choose 

Yes. 

i. You can now remove the “ASEAN_Seaport_Coordinates.csv Events” from the Table 

of Contents (Right-click > Remove) 

4. Next, we will add attributes to our new layer using a Join. 

TASK 2: JOIN ATTRIBUTES FROM A TABLE 

1. Tabular joins involve taking fields and attributes from one table and joining them to another based 

on a common identifier.  For example, you can join tables such as census statistics that are in 

spreadsheet format to an administrative boundary file in your ArcMap project.  To do so, each table 

must have a common field that can be uniquely linked together such as an administrative code. 

Tables can also be joined based on an overlapping spatial location.  

2. First, click on the Add Data icon  and navigate to the ASEAN_RVA_Exercise_5_Data to add the 

table “seaport_attributes.xls” (seaport_attributes$) 

3. Next, open the attribute table for your new layer “ASEAN_Seaports” by right-clicking the layer in 

the Table of Contents and selecting Open Attribute Table. 

4. From the Table Options button , click on Joins and Relates and click on Join as shown below. 

 



 

42 

 

5. A new Join Data window will open. 

 

a. Under Option 1: Select “portname” as the field in this layer that the join will be based 

on. 

b. Under Option 2: Click on the dropdown and select “seaport_attribute$”  

i. Tip: ArcMap may have difficulty opening Excel spreadsheets from versions later 

than 97-2003.  If your spreadsheet is in a later version, open the table in Excel 

and Save as “Excel 97-2003 Workbook” or as a “Text (Tab delimited)” file type. 

c. Under Option 3: Select “portname” as the field in this layer that the join will be based 

on.  In this instance, the field names from the two tables are the same.   

d. Join Options: Select Keep all Records  

e. Click OK 

6. You can now view the table and verify that the join was completed successfully.   
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7. Joins are not permanent. The join is only viewable within the current ArcMap project and does not 

modify the original layer in any way.  To make the join permanent, you must copy the data over to a 

Field in the original table, or export the joined data to a new layer.   

8. The fastest way to ensure all the joined Fields are capture permanently is by exporting the data to a 

new layer. 

9. Close the Attribute Table. Next, in the Table of Contents, right-click on the “ASEAN_seaports” layer 

and click on Data > Export Data 

 

10. A new Export Data window will open. Save the new layer to the ASEAN_RVA_Exercise_5_Data 

folder and call it “seaports_join.shp” 
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11. A dialog box will open that says “Do you want to add the exported data to the map as a layer?” Click 

Yes to continue.  View the new data layer and attribute table, created by joining attributes from two 

different tabular files. 

USING JOINS IN RISK ASSESSMENT AND MAPPING 

Tabular joins allow users to join tabular attributes to spatial boundaries. For example, indicators and 

indices developed for your Member State in tabular format (such as those introduced in Exercises 1 - 3) 

can be joined to province boundaries, enabling users to visualize and map the derived outputs of the risk 

assessment process.  Exercise 8 will explore map creation in ArcMap. 
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EXERCISE 6: ESTIMATING EXPOSURE 

OBJECTIVE 

This exercise will demonstrate some basic GIS tools for estimating exposure to hazards. Students will 

combine hazard zones with administrative boundaries and population information to estimate the 

population exposed to earthquakes and tropical cyclone winds. The result will be a spatial dataset 

representing exposed populations in each level-1 administrative unit across AMS. 

MATERIALS 

This exercise requires the use of ESRI ArcMap. Instructors will provide four spatial datasets: 

 Admin1_gaul_asean.shp: Shapefile contains level 1 administrative boundaries for AMS. 

 EQ_Hazard_2475y.shp: Shapefile contains the seismic hazard zone, indicating areas exposed to 

earthquake intensity MMI VII and above, based on a 2475-year return period. 

 TC_Hazard_500y.shp: Shapefile contains the tropical cyclone wind hazard zone, indicating areas 

exposed to Category 1 (119 km/h) winds or greater, based on a 500-year return period. 

 lspop2014_ASEAN.tif: Raster contains 2014 population estimates with a grid cell size of 

approximately 1 km. 

 seaports.shp: Shapefile contains major seaports in AMS. 

INSTRUCTIONS 

TASK 1: ADD DATA TO ARCMAP 

1. Open a new ArcMap document. From the Main Toolbar, Click the Add Data button:    to add 

layers to the map. 

2. Navigate to the data folder for Exercise 6 and add the following layers: 

a. EQ_Hazard_2475y.shp 

b. Admin1_gaul_asean.shp 

i. Note: you can add multiple layers at once by holding the Ctrl key  
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3.  The layers will be displayed in ArcMap. Note: you can change the 

drawing order of the layers by clicking and dragging them in the Table of 

Contents window. Layer properties and map symbology can also be 

accessed here. 

TASK 2: GET FAMILIAR WITH THE DATA LAYERS 

1. Right-click on the Admin1_gaul_asean.shp layer and choose Open Attribute Table.  

a. The attribute table contains all of the tabular infromation associated with each spatial 

feature.  

2. Scroll through the table to view the attributes. Note that the table contains Place Name, Code, and 

Population Estimate (“POP14”).  

a. Important Note: “ADM1_CODE” represents each feature’s Unique Identifier.  

i. Each Level 1 administrative unit has its own distinct code. Each code consists of only 

numbers and icontains no special characters that might not be recognized in other 

software. This ensures that additional data can be joined easily and that the 

identifier is retained if the data are exported and opened in another program (for 

example, Excel). 

3. Close the attribute table and open the 

Symbol Selector by left-clicking the 

symbol (a colored box) below the 

Admin1_gaul_asean layer in the Table 

of Contents. Click to set the Fill Color to 

“No Color” and set the Outline Color to 

black. Click OK. 

4. If you haven’t already, Drag the 

Admin1_gaul_asean layer to the top of 

the Table of Contents so that it draws 

over the Earthquake Hazard Layer, 

“EQ_Hazard_2475y”. 

5. Finally, Right-click the 

Admin1_gaul_asean layer and choose 

Zoom to Layer. The map should be re-

centered over the ASEAN member 

states. You should be able to see the 

earthquake hazard layer beneath the 

AMS level-1 boundaries: 
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TASK 3: IDENTIFY THE AREAS EXPOSED TO EARTHQUAKES 

1. To estimate the population exposed to earthquake hazards, we 

must first determine exactly which areas are exposed. To do this, 

we need to combine, or intersect the two data layers.  

2. ArcMap’s Intersect Tool allows us to combine information from the 

provinces with the hazard zone. 

a. We can access the Tool inside ArcToolbox by clicking the icon 

 in the main toolbar. 

i. Navigate to the tool by clicking through the toolboxes: 

1. Analysis Tools > Overlay > Intersect. Double-

click to open the tool.  

b. Under Input Features, click the arrow to open the dropdown 

box and select the layers to intersect. Be sure to add both layers, individually. You should 

see both EQ_Hazard_2475y and Admin1_gaul_asean listed in the “features” window.  

c. Under Output Feature Class, click the folder button  to navigate to your working folder. 

Save the feature class as “EQ_AMS_Intersect” 

d. Leave all other parameters on their default settings, and Click OK to run the tool.  
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Note: It may take a few moments to run the tool, and it will simply run in the background. When the 

process is complete, your new layer, EQ_AMS_Intersect will be added to the top of the Table of 

Contents. 

3. Carefully examine your results. Note how the results of the Intersect represent ONLY those areas of 

AMS that are within the earthquake hazard zone. These results are important for estimating how 

much of the population within each province is exposed to a particular hazard. 

TASK 4: ESTIMATE THE POPULATIONS WITHIN EACH PROVINCE THAT ARE EXPOSED 

TO EARTHQUAKES 

1. Click the Add Data button:    to an additional layer to the map: “lspop2014_ASEAN.tif” 

a. The LandScan Population dataset provides a 2014 population estimate in ~1km raster grid 

cells. We will use this dataset along with the results of the Intersect to estimate the 

population within the exposed portions of the AMS provinces. 

2. ArcToolbox’s Zonal Statistics tools allow us to calculate statistics on values of a raster within zones 

defined by another dataset (vector or raster). For our assessment, the zones are the portions of the 

AMS that are exposed to earthquakes (EQ_AMS_Intersect) and the desired statistic is the SUM of 

the population within those zones. 

a. To complete this assessment, we will need to use a set of tools contained in ArcMap’s 

Spatial Analyst Extension. From the main toolbar, click on Customize > Extensions and make 

sure that Spatial Analyst is checked. Click OK. 
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3. The Zonal Statistics as Table tool produces a table of summary values for each zone, which can be 

joined with spatial features. 

a. Navigate to the Zonal Statistics as Table tool in ArcToolbox: 

i. Spatial Analyst Tools > Zonal > Zonal Statistics as Table 

b. Under Input Raster or Feature Zone Data, choose 

EQ_AMS_Intersect (areas in AMS exposed to earthquake) 

c. Under Zone Field, choose ADM1_CODE (Remember: This is our 

unique identifier!) 

d. Under Input Value Raster, choose lspop2014_ASEAN 

e. Under Output Table, navigate to your working folder and save 

the output as “AMS_EQ_Pop” 

f. Leave the box next to “Ignore NoData…” checked 

g. Under Statistics Type, choose SUM (this will give the sum of the 

population within the exposed portions of each province). Click 

OK. 

 

 

4. To view the resulting table, you will need to change the view 

of the Table of Contents to List by Source (second button 

from the left). “AMS_EQ_Pop” will be at the bottom of the 

Table of Contents. 

5. Right-click AMS_EQ_Pop and choose Open to view the results.  

a. The SUM column provides an estimate of the 

population in each exposed province.  
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b. Next, we’ll use our unique identifier, ADM1_CODE to join the exposed population attributes 

to the AMS adm1 Boundaries so that we can view a map of our results. 

TASK 5: JOIN THE RESULTS TO THE AMS BOUNDARIES 

1.  In the Table of Contents, Right-click on 

Admin1_gaul_asean and choose Joins and 

Relates > Join… 

a. Under What do you want to join to this 

layer? Choose Join attributes from a 

table. 

b. Under Choose the field in this layer that 

the join will be based on, choose 

ADM1_CODE. 

c. Under Choose the table to join to this 

layer, choose the results of the Zonal 

Statistic, AMS_EQ_Pop 

d. Under Choose the field in the table to 

base the join on, again choose 

ADM1_CODE. 

e. Under Join Options choose Keep all 

records. Click OK 

2. Right-click on Admin1_gaul_asean and choose 

Open Attribute Table 

a. Scroll the whole way to the right to see that the results of the Zonal Statistic, including the 

SUM column, are now Joined to the AMS boundaries. You may notice that some provinces 

have NULL values in the SUM column. In these cases, the province was outside the 

Earthquake Zone, so these areas were excluded from the intersect and zonal statistic. In 

these places, the exposed population is zero (0). 

3. Joins are NOT permanent. To permanently attach the exposed population estimate to the AMS 

boundaries, we must Export the data layer: 

a. Right-click on Admin1_gaul_asean and choose Data > Export Data. 

b. Click the folder icon to navigate to your working folder. Save the layer as 

“AMS_EQ_Exposure”. Under Save as type, choose Shapefile.  
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i. Note: For our purposes, the Shapefile is useful for a few reasons. First, this file type 

can be opened and edited easily in QGIS. Second, the Shapefile file type 

automatically converts NULL values to zero. In our case, this is desirable, because 

NULL values correspond to zero exposed population. 

ii. Click Save, then Click OK. When it asks “Do you want to add the exported data to 

the map as a layer?” - Click Yes. 

c. Open the Attribute Table for your new layer, AMS_EQ_Exposure. Notice how all the values 

that were previously NULL are now zero. 

4. As a final exploratory summary, Right-click the SUM column and Choose Statistics… to compute 

summary statistics on the population exposed to earthquake hazards in AMS. 

 

a. Next, Calculate Statistics on the POP14 column. 

b. Question: What percentage of the total population is exposed to earthquake hazards in 

AMS? 

TASK 6: ESTIMATE THE POPULATION EXPOSED TO TROPICAL CYCLONE WINDS  

1. Add the TC_Hazard_500y.shp data layer to the map.  

2. Repeat Tasks 3 through 5 above to intersect the administrative boundaries with the tropical cyclone 

hazard zone and estimate exposed population exposed to tropical cyclone wind. 

a. As you work through each task, remember to save your data layers in your working folder. 

Choose intuitive file names that make sense to you. 

OPTIONAL TASK: ESTIMATING SEAPORT EXPOSURE 

1. In addition to population, estimating the exposure of critical infrastructure, such as major seaports, 

is important for anticipating potential losses or obstructions to disaster relief operations. 

2. Add “seaports.shp” to your map.  
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3. To determine which seaports are exposed to Earthquakes, Intersect seaports.shp with the 

EQ_Hazard_2475y layer (ArcToolbox > Analysis Tools > Overlay > Intersect). Save the new layer as 

EQ_Seaports_Intersect. 

4. Repeat this step with TC_Hazard_500y to determine which seaports are exposed to tropical cyclone 

winds. 

Alternate Method: Select by Location 

1. To determine the exposure of the seaports 

without running a tool or creating a new layer, 

choose Selection > Select by Location from the 

top menu. 

a. Under Target Layer, choose seaports 

b. Under Source layer, choose 

TC_Hazard_500y 

c. Under Spatial selection method…, choose 

“Intersect the source layer feature” 

i. Click OK 

2. The features selected in seaports layer (shown 

below) represent those that fall inside the 

TC_Hazard_500y zone. 

a. Attributes of these features can be viewed 

by opening the attribute table. 

 

 

 

 

 

 



 

53 

 

3. If desired, selected features can also be exported as a separate layer. As practiced above, right-click 

the seaports layer from the Table of Contents and choose Data > Export Data. This time, however, 

ensure that Selected Features are chosen at the top of the window: 
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EXERCISE 7: CREATING AN EXPOSURE INDEX 

OBJECTIVE 

This exercise will demonstrate the steps required to calculate indicators of multi-hazard exposure, and 

will follow the process of indicator normalization (or scaling), compression and aggregation to construct 

an exposure index. The result will be a complete Multi-Hazard Exposure Index, one of the component 

indices of the Societal Risk Index. This exercise will draw upon skills developed in exercises 1, 2 and 3 

from data preparation through index construction. 

MATERIALS 

This exercise requires the use of Microsoft Excel. Instructors will provide two Excel Workbooks: 

 Exercise_7_Sample_Data.xlsx:  This file contains sample raw data including population exposed to 

earthquakes, tropical cyclones, and floods. Students will use this data to calculate indicators of 

multi-hazard exposure. 

 ASEAN_RVA_Template.xlsx: This Excel Workbook is designed as a guide through the process of 

Index Construction for the ASEAN Risk and Vulnerability Assessment (RVA). It provides field names 

descriptions, examples, and templates that are used throughout the training and exercises. In this 

Exercise, we will use this template to construct a sample Multi-Hazard Exposure Index. 

INSTRUCTIONS 

TASK 1: GETTING FAMILIAR WITH THE RAW DATA 

1. Make a copy of the Excel workbook “Exercise_7_Sample_Data.xlsx” file to work from. The table 

contains the sample raw data that you will use to derive the multi-hazard exposure indicators. 

The workbook contains two worksheets:  

a. Raw_Data_Descriptions: Contains field names and descriptions for the raw exposure data. 

b. Exposure_Raw_Dataset: Contains the raw data that will be used to derive the multi-hazard 

exposure indicators. 

TASK 2: DERIVING RAW MULTI-HAZARD EXPOSURE 

1. Just as you practiced in Exercise 3, you will prepare these raw datasets for index construction by 

calculating derived indicators. The worksheet contains 4 datasets for each sample province: Total 

Population, Population Exposed to Earthquakes, Population Exposed to Tropical Cyclone Winds, 

and Population Exposed to Flood. Keep in mind that these are sample data and do not represent 

the full range of hazards identified in the Guidelines. 
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2. The first indicator that you will derive is Raw Multi-Hazard Population Exposure, or the raw count 

of “person units” exposed to one or more hazards. In this example case, those hazards include 

earthquakes, tropical cyclone wind, and flood inundation. 

a. Looking at exposure as raw counts provides an indication of how many or how much, which 

can assist in planning and give an idea of the raw scale of potential activities, such as 

evacuation or sheltering. 

3. Create a new column heading in the worksheet called “RawPopExp” (Raw Population Exposure). 

 

4. To calculate raw multi-hazard exposure, combine the population counts from each of the hazard 

types by simply adding the population exposed from each of the three hazards: 

 

a. To apply the calculation to all provinces, Copy and Paste the formula to each row. 

TASK 3: DERIVING RELATIVE MULTI-HAZARD EXPOSURE 

1. The second indicator that you will derive is Relative Multi-Hazard Population Exposure, or the total 

count of person units exposed to multiple hazards as a proportion of the province population. 

a. Representing exposure as a proportion of the total population provides an indication of how 

important and can assist with prioritization. Including relative exposure also helps highlight 

the relevance of hazards to provinces with small populations or economies during 

comparative analyses. 

2. Create a new column heading in the worksheet called “RelPopExp” (Relative Population Exposure). 

5. To represent relative multi-hazard exposure, we will calculate the total population count exposed to 

one or more hazards (i.e. raw exposure) per 1,000 persons in the province. The syntax for the 

calculation is [RelPopExp] = ([RawPopExp] / [TotalPop]) * 1,000. You could also calculate the 

proportional exposure for each type of hazard for inclusion in a GIS layer using the same basic 

syntax. 

 

a. Again, to apply the calculation to all provinces, Copy and Paste the formula to each row. 
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TASK 4: MHE INDICATOR PREP AND SCALING 

1. Now that we’ve derived our indicators, raw multi-hazard population exposure (“RawPopExp”) and 

relative multi-hazard population exposure (“RelPopExp”), we can draw upon our skills practiced in 

Exercise 2 to prepare and scale the indicators.  

2. Open your working copy of the Excel Workbook “ASEAN_RVA_Template.xlsx.” Using the tabs at the 

bottom of the workbook, open the MHE_Template worksheet. 

a. Just like you practiced in Exercise 2, you will copy and 

paste the derived indicators into the yellow columns in 

the template. Be sure to Paste as Values.  

3. After you’ve pasted your data for “RawPopExp”, scroll to the bottom of the worksheet: 

a. Minimum and maximum exposure values based on regional patterns (such as those 

provided for the Vulnerability indicators used in Exercise 2) are forthcoming. Instead, this 

exercise demonstrates how to scale the exposure data using minimum and maximum values 

based on the distribution of the sample data. Note: This is the methodology you would use 

to generate country-specific indicator scores for a more customized assessment. 

 

 

 

 

 

 

 

b. For Scaling the Exposure Indicators: 

i. RVA Min = Mean minus two standard deviations 

ii. RVA Max = Mean plus two standard deviations 

4. Important Note: For each indicator, you must check to ensure that the minimum values make sense. 

In “RawPopExp” we are measuring the number of people exposed to one or more hazards. The 

minimum value calculated using the equation above is negative. Since it is not possible to have 

negative population exposure, we need to set the minimum 

value to zero. The worksheet contains conditional formatting 

to indicate where minimum values will need to be reset. 
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a. When the value is set to zero, the cell is no longer highlighted in red (as shown in the 

image). 

5. Next, check to see if the indicators need to be compressed. Any scaled values in “RawPEScale” that 

are greater than 1 or less than 0 must be compressed. 

a. Just like Exercise 2, the template will indicate values that require compression by 

highlighting them in red. 

b. Copy and Paste the scaled values from “RawPEScale” to “RawPECompr” (Use Paste Values). 

c. To compress these values: 

i. Assign a value of 1 where the scaled values are greater than 1. 

ii. Assign a value of 0 where scaled values are less than 0. 

 

6. In contrast to the Vulnerability Index, it is NOT likely that the exposure indicators will require 

reflection. Reflection is not necessary where there is a directional match, or, where higher values 

equal worse conditions. For example, a higher raw population exposure indicates higher overall 

multi-hazard exposure (a directional match). 

a. As a result, the “Score” and “Rank” columns in the MHE_Template will automatically 

update as values are checked for compression.  

7. Repeat the steps in this task to prepare and scale the Relative Multi-hazard Population Exposure, 

“RelPopExp”. 

TASK 5: MHE INDEX CALCULATION 

1. As noted in Exercise 3, much of the index aggregation process is automated in the template. In this 

exercise, we combine just two indicators – Raw Multi-hazard Population Exposure, and Relative 

Multi-hazard Population Exposure – in the calculation of the Multi-hazard Exposure Component 

Index, “MHEIndex.” Examine the formula used to calculate MHEIndex. 

 

a. Notice that we did not construct subcomponent indices. This is because we included only 

two indicators, both of which represent exposure of one element – Population.  
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b. If we could include additional elements, such as the value of exposed building stock, we 

could construct separate thematic subcomponents for population exposure and economic 

exposure. 
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APPLYING RVA OUTPUTS TO DECISION MAKING 

EXERCISE 8: INTRODUCTION TO MAP DEVELOPMENT AND EXPORT 

OBJECTIVE 

This exercise introduces the steps required to develop a map in ArcMap for the purposes of exporting 

and printing. Using files and symbology developed and saved in Exercise 4, each participant will create 

their own map product, including basic cartographic design elements and principles. The result will be a 

digital map, both in the form of an ArcMap Document and PDF or JPEG. 

MATERIALS 

This exercise requires the use of ESRI ArcMap. To make your map, you will use the ArcMap document 

(.mxd) and spatial data from Exercise 4. 

INSTRUCTIONS 

TASK 1: PAGE SETUP 

1. Open the .mxd file that you generated in Exercise 4. 

2. Before creating your map, it is recommended that you define your map 

width and height within the Page and Print Setup menu.   When 

creating a map to publish and print, it’s generally best practice to design 

your map to using the desired layout size to ensure appropriate scale 

and organization of cartographic elements. 

3. Click on the File dropdown menu and select Page and Print Setup 

4. You can select a predefined Printer Paper Setting if you have printers 

configured on your computer, or define a custom extent and 

orientation between portrait or landscape mode.   

5. Find and Select 11x17 inches (~28x43 centimeters) and change the 

orientation to landscape and click OK. 

a. If you do not have a predefined page size, you can uncheck 

“Use Printer Paper Settings” and enter the parameters 

manually. 

TASK 2: CREATING A MAP IN ARCMAP 

1. Using our symbolized data from Exercise 4, we will look at the basic steps to create a map in ArcMap 

using the Layout View.  You can toggle between the Data View and Layout View by clicking on the 

View dropdown menu and selecting Layout View. 
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2. You are able to change the size and shape of the Data Frame by clicking and dragging the vertices of 

the map.   

3. Reshape the Data Frame to fit the Layout extent if needed similar to the image below. 

 

4. In map design, there are basic cartographic elements that are essential to every map: Title, legend, 

scale, and north arrow.  Other elements might include data sources, publication data, and use 

limitations. Below, we will practice adding essential cartographic elements to the map. 

Adding a Legend 

1. Under the Insert dropdown menu, you will find options to add other elements to your map.  Next 

we will add a Legend. 
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2. Click on the Legend button under the Insert dropdown menu.   

3. A Legend Wizard window will open.  There are many options to customize how a legend will look.  In 

the first dialog window, you two lists of layers; the Map Layers list will show all available map layers 

in your Table of Contents; the Legend Items by default only show the layers that are active in your 

Table of Contents.  You are able to add and remove layers by selecting the arrow keys.   

 

4. The next window will provide options for your Legend Title, similar to the text properties we looked 

at earlier. 
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5. Click through the remaining windows until finished.  You can change the legend parameters again if 

you need to. 

6. The Legend is dynamically linked to your Table of Contents.  For instance, if you change the name of 

a layer in the Table of Contents, the name will change in the Legend. 

7. Change the name of “Admin0_gaul_asean” in the Table of Contents to “ASEAN Population”.   

a. Hint: Right-click on the “Admin0_gaul_asean” in the Table of Contents and select 

Properties. Under the General tab, you can change the Layer Name. 

8. Notice the Legend updated with the new name of the layer. 

Adding a Title 

1. To add a title to you map, click on Title under the Insert dropdown menu. 

2. Type an appropriate title for your map to summarize the key information or purpose of the map. For 

example, you could call this map “ASEAN Population 2014” 

3. Click and drag the title to an appropriate area on the map 

4. Note: You can edit the title, including the text and font, by double clicking, or right-clicking and 

selecting Properties. 

Adding a Scale Bar 

1. A scale bar is a graphic element that represents the scale of a map.  Click on the Scale Bar button 

under the Insert dropdown menu.   

2. A Scale Bar Selector window will open providing a number of options.  Select any type of Scale Bar 

then click on the Properties button. 
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3. A Scale Bar properties window will open allowing you to change the Division Units, Label, Position, 

and other customization options.  Once completed, click OK.  You will be able to modify the 

properties at any time by double clicking on the Scale Bar in your Layout View. 

 

4. Go back to your Layout View and examine the Scale Bar.  Similar to adjusting the size and shape of 

the Data Frame, you are able to adjust the size and position of the Scale Bar by clicking it and 

moving the vertices. 
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Adding a North Arrow 

1. Under the Insert dropdown box select North Arrow. 

2. Select a basic north arrow to add to your map, such as ESRI North 2: 

3. From the map, you are able to adjust the size and position of the north arrow by clicking it and 

moving the vertices. 

OPTIONAL: Adding Text to a Map 

1. When making a map, it may be useful to add text annotation to the layout such as a description or 

data source. 

2. Text can be added two ways: 1) Insert > Text, or 2) Using Draw toolbar (shown below).  If you do not 

see the Draw toolbar, try clicking on the Customize > Toolbars menu at the top of the application 

and make sure Draw toolbar is checked 

 

a. Note: From the Draw toolbar, you can click on the Text button  to add text.  A small 

text box will appear where you clicked.     

3. You can double click on the  box you placed to edit text and font. 

OPTIONAL: Customize Your Map 

If there is time, you might want to further customize your map using the tools, techniques, and data 

resources that you’ve explored throughout the training exercises. In Exercise 9, you will develop and 

present a customized map and/or data product to help answer a relevant question raised in discussion 

with policy and decision makers.    

TASK 3: EXPORTING YOUR MAP 

1. When your map is complete, you can export your map to variety of formats including PDF and JPEG. 

2. Click on the File dropdown menu and select Export Map… 

3. From here you can add a File Name, change the file type, and modify the resolution of the map. 

4. Navigate to your working folder for this exercise, and click the Save button. 

 

 


